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1. How to Install

If you did not unzip this unto a floppy, you will need to move all of these files to 
your A: drive.

The install.dot file should be in the root directory of drive A:

The *.ini files should be in a sub directory called A:\FAST!

Insert your disk containing the files into drive A:. Start Windows™, then start 
Microsoft Word™. Close all active files. Then, open the Word™ Document Template
“A:\Install.DOT”. The installation will prompt you for everything else.

When you exit Word™, it will ask you if you want to save changes to the Global 
Glossary/Document Template. Click “Yes”.

Note:If you are not familiar with the particulars of document template usage in 
Microsoft Word™, please read the next section...

2. Using the Accessories

To use the CCC Cybernetics FAST!™ accessories, choose “Macro” from the “Tools”
menu. Then choose the accessory you would like to run. If you ever wish to abort the
operating accessory, press the ESC key. This is not recommended, however.

Note:It is much faster if you add the accessories to you toolbar. See section below.

3. Global and Local Use

When an architect draws a floor plan, he/she will often use a template to trace 
common items, such as bathtubs or appliances. This saves a lot of time the architect 
would have spent drawing these items from scratch. Microsoft Word™ allows the 
user to establish document “templates” with many useful attributes, including style 
palettes, macros and toolbars.

For example, if I were doing company press releases on a regular basis, I might 
create a template that had my name and address as a press contact at the top, and 
styles established for headings and body text. I might also have a button on my 



toolbar that uses a macro to startup my fax-modem and fax copies of my press release
to all my contacts.

But, I wouldn’t want all of this data to appear when I want to write a note to a friend. 
So, I store the press release information in a Document Template called 
“Press.DOT”. That way the information will only appear when I create a new 
document based on my press release template—instead of every time I start Word™. 
(Use “New” from the “File” menu instead of the “Default New” button on the toolbar
to see your existing document templates.) This information is called “Template” or 
“Local” information. Changing the information in a document based on a template 
does not change the template itself, so you can re-use that template again and again 
without having to change anything.

But what if I do want an item to appear every time I start Word™? Microsoft Word™
has its own template called “Normal.dot” that it uses to store functions and styles that
are available every time you start the program. Macros stored in the “Normal” 
template are available even if you open a different template. This information is 
called “Global”.

If you want the CCC Cybernetics FAST!™ accessories to be installed so that you can
use them anytime, choose the “Normal.dot” This template will be in your WinWord 
directory. If you only want to use the tools sometimes, then choose a different 
template.

If you still aren’t sure, check your Microsoft Word™ Users Manual for additional 
explanation.

4. So What Do These DO, Anyway?

Revert
Revert restores the current document to its last save. (Say you are editing a document,
and you realize that you have irreparably messed it up and want to return to your last 
save.) It is essentially the same  as closing a document without saving, then opening 
it again.

QuickTools
QuickTools is a user-editable “Launch List” for Microsoft Word™.(For example, you
might frequently use “calculator” when you are typing documents at work. This will 
save switching to Program Manager, opening Accessories and launching calculator 
before you can return to your work.)

The launch window will store any five items. The “edit” button brings up a dialog 
where the user can add new items to the list by simply entering a description and the 
complete path and command line.

Please note, the total of your paths and descriptions should be less than 256 
characters. However, unless you have exceptionally long paths, this should not be a 
problem.



DocFormat
This accessory is designed for performing tedious pre-press operations on a Word™ 
document. It corrects a variety of common typist errors and corrects the document so 
it can be properly typeset. It also has several shortcuts for formatting bibliographies 
or lists of addresses.

DocFormat also stores four user-defined presets. This is useful if you use a certain 
combination of settings frequently. To save a preset, simply select the options you 
want and push the “Save as New Preset” button. A dialog box will prompt you for a 
name for your new preset and ask you which preset you would like to replace. The 
name may include spaces.

IMPORTANT NOTE: If you use the “Convert to Paragraph Spacing” Function, be
sure to apply your styles after you run DocFormat. Applying 
paragraph styles before you do so may cause you to have to 
re-do all that work.

5. DocFormat, An In-Depth Explanation

If you are not a heavy-duty user of word processors, or are not an experienced 
typesetter, some of the features of DocFormat may be unclear. The following is a 
complete explanation of DocFormat’s features and why they are useful.

Convert Document to Paragraph Spacing
Ever look at a magazine or book and notice how all of the columns neatly line up at 
the bottom of the page, even though the text in the section might be different point 
sizes? Ever tried to do that yourself by double-spacing between paragraphs? It’s 
nearly impossible! Typesetters use something called “paragraph spacing” to line up 
text and prevent unsightly gaps.

Microsoft Word™ supports paragraph spacing, as well as “hard” and “soft” carriage 
returns. To see these characters in your Word™ document, press the “Show/Hide 
Special Characters” button on your Ribbon Bar.(It looks like a backward “P” with an 
extra line on it.) In your document, a hard return will look like the symbol on the 
“Special Characters” button. A soft return will look like an arrow with a tail on it—
the same symbol as on the ENTER key on most keyboards.

Any typist knows that when you type on a manual typewriter, you must put a carriage
return (or “hard” return) at the end of each line, and two at the end of each paragraph.
Most people who use a word processor know that you should “let the text flow” in 
your paragraphs, and the computer will break the text at the correct places for you. 
However, most people who use a word processor still put two hard returns at the end 
of each paragraph.

When you use a page-setting program, such as Aldus PageMaker™ or Quark 
Xpress™, or a sophisticated word processor such as Microsoft Word™ (Sorry, guys, 
Word Perfect™ for Windows does not fully support these features!) a paragraph 
should only have ONE hard return at the end of it.

“But won’t all the paragraphs run together?”, you ask. This is when you adjust the 



paragraph spacing. To correct the paragraph spacing in a Word™ document, first 
highlight the paragraph. Then select “Paragraph...” from the “Format” menu. You 
will see an option group entitled “Spacing” with the options “Before” and “After”. 
Enter an appropriate value in these boxes. An appropriate value for 10pt. body text 
would be 0 inches before, and somewhere between .056 and .083 inches after. An 
appropriate value for a paragraph that is a heading would be .056 inches before, 
and .022 inches after. Word™ will also allow you to save paragraph spacing values as
part of a style. As a matter of fact, the default styles Heading 1, Heading 2 and 
Heading 3 have paragraph space already built in!

“But what if I have a list in my document!” This is when you use a “soft” return. A 
soft return is like a hard return, but does not end the paragraph. It is useful when you 
don’t want text to run together, but you do not want space after it—nor do you want 
to change the paragraph style. An address, for example, should have a soft return at 
the end of each line and a hard return at the end of the whole thing. You can get a 
soft return in Microsoft Word™ by pressing SHIFT+ENTER at the same time.

In the DocFormat accessory, “Convert Document to Paragraph Spacing” takes a 
traditionally typed document and converts it to a correctly typed document with 
paragraph spacing. Anywhere there are two hard returns, it converts them to a single 
hard return. Anywhere there is a single hard return, it converts it to a soft return. It 
does not affect single, pre-existing soft returns. You will need to add the amount of 
paragraph spacing you want to your existing styles.(See directions above.)

Remove Boldface
This will remove all boldfacing in a document.

Remove Italics
This will remove all italicizing in a document.

Remove Underlines
This will remove all underlining in a document.

A properly formatted document should never use underlining—if you look at 
underlined type, you will notice that it lays too close to the baseline of the characters,
making them less readable. You will also notice there are tiny breaks in an underline 
between characters. This looks very unprofessional.

Your English teacher may have told you that book titles and the such should be 
underlined, and stories quoted. In reality, book titles should be italicized and stories 
quoted. Underlines exist because manual typewriters can not produce italicized type. 
Body text that is underlined for emphasis should be boldfaced.

“What if I want to make a heading look underlined for emphasis?” This is when you 
use what is called a “Paragraph Rule”. A paragraph rule is similar to an underline, but
you can change the distance it is from your type and preserve readability. A 
paragraph rule is also a continuos line—there are no breaks between characters. You 
can also change its thickness and other attributes.

To give a paragraph a paragraph rule in Word™, first highlight your selection. Then 



choose “Border” from the “Format” menu. Click on the bottom of the “type” in the 
little picture on the left hand side of the dialog. Choose your line style from the 
pictures on the right, and then enter an appropriate number in the “Distance from 
Text” box. One point is good for 10pt. text.

Replace excessive spacing with tabs
Manual typewriters are only capable of what is known as “monospaced type”. 
Monospaced type means that each character takes up exactly the same amount of 
space. Some fonts on your computer, such as Courier, are also monospaced.

Most modern fonts, however, are “proportional”, meaning that each character takes 
up a slightly different amount of space in order to increase readability. Traditional 
fonts that typesetters use, such as Times or Helvetica, have always been proportional 
fonts.

When a manual typist wants to type a numbered list, for example, he/she will 
commonly type the number and put five or so spaces in front of the item. This works 
fine for the typist because the typewriter is monospaced. Try and do the same thing 
on a computer with a proportional font, however, and the list ends up ragged!

Example:

Item One (1)     This is a list
Item Two (2)     Using monospaced type.

Item One (1)     This is a list
Item Two (2)     Using proportional type.

The  solution? Use tabs instead of spaces! Tabs will ensure your type is always in the 
same place. To set tabs in Word™, highlight your selection and click on the ruler 
where you want the tab to be.

DocFormat’s “Replace Excessive Spacing With Tabs” will replace sequences of three
or more 
spaces with a tab.

Correct Dashes and Hyphens
Your English Teacher probably also told you that you should put a double-hyphen or 
a hyphen with spaces around it between phrases. For example:

The chicken crossed the road to get to the other side--but he didn’t anticipate the fox!
The chicken crossed the road to get to the other side - but he didn’t anticipate the fox!

Both of these, however, are incorrect. In typesetting, there are three major categories 
of dashes. They are the “hyphen”, the “en dash”, and the “em dash”. The dash that 
goes between compound words is the hyphen. The dash that goes between phrases is 
the em dash, which is slightly longer than the hyphen. The en dash is shorter than a 
hyphen, and is used for things such as dates or times.

You can access the en dash in Word™ by holding down the ALT key and typing 
0150 on the numeric keypad. You can access the em dash by holding down ALT and 
typing 0151 on the numeric keypad.



The “Correct Dashes and Hyphens” option in DocFormat changes all traditional 
variations on the double-hyphen to an em dash. It also changes existing hyphens into 
non-breaking hyphens so phone numbers and compound words are not broken up 
over a line break.

Remove Trailing Spaces
This removes trailing spaces at the end of paragraphs.

Make Addresses Into Independent Paragraphs
Typists will often omit the double hard return when a description follows an address. 
“Make Addresses Into Independent Paragraphs” separates the address and the 
description into independent  paragraphs so that you may apply a style to an address 
without affecting the description. For example, you may want to justify your 
descriptions, but you will want to left-set the addresses.

Boldface the First Line of Each Paragraph
This will boldface the first line of every paragraph in your document.

This function is useful for lists of addresses or bibliographies. If you have a list of 
addresses, however, and you have put hard returns at the end of each line, don’t 
forget to “Convert to Paragraph Spacing”. Word™ considers every hard return the 
end of a paragraph, and so does DocFormat—if  you don’t use paragraph spacing, 
your entire document will end up bold!

Sort Paragraphs in Alphabetical Order
This will sort all the paragraphs in your document into alphabetical order.

This function is also useful for lists of addresses or bibliographies. Don’t forget—a 
hard return denotes the end of a paragraph here too! If your list of addresses does not
use paragraph spacing and does not have soft returns instead of hard returns 
between each line, they will end up jumbled!

Remove Sentence Double-Spacing
Traditional typists using a manual typewriter will put two spaces after every sentence.
This is fine, since a typewriter uses monospaced type (see above for definition). 
However, the fonts you find on your computer are normally proportional. In a 
proportional font, such as Times, that extra space after a period or explanation point 
is already built into the font. If you put two spaces after each sentence, it will cause 
an unsightly gap and look far less professional than a sentence with only one space. 
“Remove Sentence Double-Spacing” removes these extra spaces between sentences.

Convert Quotes
When most people want to use a quotation mark or an  apostrophe, they use the 
straight up and  down dash and double dash, normally found near the ENTER key on 
most keyboards. Contrary to popular belief, these are NOT quotation marks or 
apostrophes. These marks denote inches and feet, minutes and seconds, or division 
marks when referring to lines of latitude and longitude.

Quoted words and contractions should use what are called “typographer’s quotes” or 



“curly quotes”. They can be accessed in Word™ by holding down the ALT key and 
typing numeric keypad 0147 (open quote), 0148 (closed quote), 0146  (apostrophe), 
or 0145 (reversed apostrophe).

Example:

This is a “correct” example of quotation marks. This sentence is about 4.5" long.

This is an "incorrect" example of quotation marks. This sentence is about 4.75" long.

DocFormat’s “Convert Quotes” will convert all inches and feet marks into proper 
quotations. When they are following an ordinal number, DocFormat will assume that 
they are denoting a mathematical expression and ignore them.

6. Adding Accessories to Your Toolbar

Microsoft Word™ will allow you to create a custom toolbar. If you would like to add
the CCC Cybernetics FAST!™ accessories to your toolbar, first open the original 
document template 
that contains the accessories. If you have installed the accessories globally, you do 
not need to 
open anything.

Choose “Options...” from the “Tools” menu. Scroll down the “Categories” icon-bar 
on the left of the dialog until you see the icon for “Toolbar”. Click on the “Toolbar” 
icon.

In the “Show” option group, click on “Macros”. Choose the appropriate context from 
the “Context” option group. Select a tool to change from the list box, pick an icon 
from the other, and then click on the accessory you would like to add to your toolbar.
When you have made your selections, press “Change”. When you are done making 
changes, click on the “Close” button.

Word™ will prompt you to save changes to the Global Glossary/Document Template 
when you end the session. Click the “Yes” button.

7. Adding Hot Keys

The procedure for changing keyboard shortcut keys is virtually the same as altering 
the toolbar. Simply choose the “Keyboard” icon after you click “Options...” on the 
“Tools” menu. 
(see section above.)

8. Disclaimer Licensing/Distribution Information

CCC Cybernetics FAST!™ accessories are distributed “as is”.

Use of these programs are at the user’s own risk. The user is fully responsible for any
and all damages or alterations to their equipment or data.

If you, your computer or Microsoft Word™ explodes, loses data, or is otherwise 
damaged, impaired, possessed by evil spirits or absolutely anything else because of 
this program TOUGH ROCKS! There is however, no known reason why this should



ever happen if used properly.

NO commercial use of CCC Cybernetics FAST!™ accessories or their component 
parts is permitted. NO capital gains are permitted through distribution or copying of 
this product or its components. Intellectual theft of any of the programming or design
techniques used in CCC Cybernetics FAST!™ accessories or its component parts 
may be subject to prosecution. Licensing of techniques, components, or concepts may
be available with prior written consent of the author.

CCC Cybernetics FAST!™ accessories may be distributed freely as long as all files 
are distributed 
one-hundred percent intact and together. Users interested in future releases and other 
accessories may find out more information by sending e-mail or a SASE to the 
address below. (Please allow plenty of time for me to get back with you.) If you have
any questions or suggestions, please feel free to pass them along.

Users of CCC Cybernetics FAST!™ accessories absolutely agree to all conditions 
mentioned above.

All trademarks, company names and product names listed in this document are the 
property of 
their respective owners.

9. About the Author

Lisa R. Carter is co-editor of Game Zero Magazine™ and a professional typesetter 
with 
Metropolitan Graphics.
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gmezero@primenet.com
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